
สวนประกอบของโปรแกรม Dreamweaver 

เมื่อรียกโปรแกรม Dreamweaver ขึ้นมาแลวคุณจะพบวินโดวของโปรแกรม และวินโดวของเครื่องมือตางๆที่ใชในการ
ทํางาน ซึ่งกอนที่คุณจะเรียนรูการใชงานโปรแกรม Dreamweaver คุณควรทําความเขาใจเกี่ยวกับสวนประกอบ และ วินโดวเครื่องมือ
ตางๆเหลานี้กอน เพื่อนเปนพิ้นฐานในการใชงานของโปรแกรมอยางคลองแคลวและชํานาญในอนาคตสําหรับสวนประกอบที่สําคัญ
ของโปรแกรม Dreamweaver จะแสดงดังรูป ซึ่งหากคุณตองการทราบหนาที่หรือความหมายของสวนประกอบและเครืองมือตางๆ นี้  

 

ไตเต้ิลบาร เปนสวนที่อยูบนสุดครับ มีหนาที่ในการแสดงชื่อไฟล ช่ือเวบเพจ ปุมยอขยายและปดหนาจอ เหมือน Title ของ Html  
เมนูบาร เปนแถบแสดงคําสั่งตาง ๆ ทั้งหมดของดรีมฯ สามารถเรียกไดจากที่นี้ถามีคําสั่งตัวใดตัวนึงหายไป โดยจะจัดเปนหมวดใหทํา
การคนหาไดงายและสะดวก  
หนาตางออบเจ็กต เปนที่รวบรวมออบเจ็กตที่มีลักษณะเปนปุมเก็บไวเปนหมวดหมู สําหรับใสออบเจ็กตลงในเวบเพจของเรา เพื่อ
ตกแตงและเพิ่มความสามารถใหกับเวบที่เราสรางขึ้น  
หนาตาง PROPERTIES มีหนาที่ในการกําหนดลักษณะรูบรางของเวบเราเชนตารางกี่ชอง ขนาดกวาง เทาไหร ยาวเทาไหร จัด
ขอความใหอยูก่ึงกลางก็ไดชิดซายหรือขวาก็ได และยังสามารถกําหนดจุดเชื่อมโยงเวบได ในชอง link   
หนาตาง Launcher เปนหนาตางที่รวบรวมปุมที่เช่ือมโยงการปดหรือเปดหนาตางใชงาน ที่เปนเครื่องมือสําคัญ ๆ ตาง ๆ 
ประกอบดวยหนา Site , Library , Html Source , Behavior , Css Style  
แถบสถานะ Status bar เปนบริเวณแสดงขอมูลของเอกสารเวบเพจ เชน แสดงขนาดของเอกสารหรือ ขนาดของหนาจอที่ใชสําหรับ
การสรางเวบเพจ หรือแสดงระยะเวลาของการดูแลขอมูลขนาดของเวบเพจที่บราวเซอร รวมทั้งแสดงลันเซอร (Launcher)  
Web Page เปนบริเวณที่ใชสําหรับสรางเนื้อหาของเวบเพจ โดยการนําขอความหรือ ออบเจ็กตตางๆมาใสรูปภาพ ตาราง และ อื่นๆ 
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การต้ังคาของ Document 
        เลือก Modify >Page Properties หรือ Clrt J จะชวยใหทํางานไดเร็วขึ้น 

 

     Title ใสช่ือหัวเรื่องของหนาเอกสารเว็บเพจ ที่ตองการใหแสดงบน Title Bar 
     Background Image เปนการใชรูปมาทําเปน background ถารูปมีขนาดเล็กทางโปรแกรมจะจัดเรียงเปน Patten  
                เรียงรูปซ้ํากันเปนแบบตาราง 
     Background สีพ้ืนของเวบสามารถเลือกสีไดตามตองการโดยการ Click ที่ชองสี จะมีจานสีใหเลือกดังภาพดานลาง 

 

     Text เปนสีของตัวอักษรสีมาตราฐานคือสีดําสามารถเลือกได 
     Link สีตัวอักษรที่เปน Link มาตราฐานจะเปนสีน้ําเงิน 
     Visited Link เปนสีสําหรับ Link ที่ไปมาแลว 
     Active Link เปนสีในขณะที่ Click Link 
     Document Encoding ใหเลือกเปน Other 
     Click Apply 
     Click Ok 
     จากนั้นจะกลับมาที่หนา Document พรอมกับความเปลี่ยนแปลงของสีพ้ืนจะเปลี่ยนเปนสีที่ไดทําการเลือกไว 
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การบันทึกโฮมเพจ (Save) 
            หลังจากสรางโฮมเพจมาบางพอสมควรแลว สิ่งที่ไมควรลืมก็คือการบันทึกผลงานที่ไดสางขึ้นนี้ไวในไฟลนามสกุล .htm 
หรือ html โดยต้ังช่ือใหสัมพันธืกับเนื้อหาภายในโฮมเพจ ทั้งนี้จะไมทําใหเกิดการสับสนไดในภายหลัง ซึ่งจะมีผลทําใหงายตอการ
ตรวจสอบ และจัดการเว็บไซตอีกดวย ขั้นตอนการบันทึกโฮมเพจดวยวิธีการที่คุนเคย คลายกับการบันทึกไฟลทั่ว ๆ ไป ดังตอไปน้ี 
         1. คลิกที่เมนู File > Save หรือกดปุม <Ctrl+S> 
 

 
 

         2. เมื่อปรากฏไดอะล็อกบ็อกซ ใสช่ือไฟลของโฮมเพจ เชน "siampage.html" ลงในชอง File name 
         3. ดับเบิ้ลคลิกเมาสเลือกกําหนดไดเร็คทอรี่ที่ตองการสําหรับเก็บไฟลในชอง Save 
         4. คลิกปุม Save เพื่อทําการบันทึกไฟล 
ดูโฮมเพจที่สรางขึ้นดวย Browser 
          ในขณะที่ทําการสรางโฮมเพจอยูนั้น คุณตองการที่จะตรวจสอบหนาตาของโฮมเพจที่สรางขึ้นนี้ โชคดีที่ Dreamweaver 
ไดเตรียมขั้นตอน Preview in Browser เอาไวสําหรับดูโฮมเพจไดทุกครั้งที่ตองการ โดยไมจําเปนตองบันทึกโฮมเพจที่กําลัง
สรางไวในไฟลใด ๆ กอนดูก็ได นอกจากนี้หากมีการใสฟงก็ช่ัน , JavaScript , VBScript , ActiveX-Control , Plug-in 
(หากทําการติดตั้งไวแลวที่บราวเซอร) รวมถึงจุดเชื่อมตอไปยังโฮมเพจอื่น ๆ ลงในโฮมเพจนี้ก็สามารถใชงานไดอยางครบถวนดวย 
           การดูโฮมเพจที่สรางขึ้นดวย Browser ทําไดโดยการกด F12 
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การสรางงาน 
           หลังจากไดเรียนรูขั้นตอนการตั้งคาตางๆ เปนที่เรียบรอยแลวตอไปก็จะเริ่มขั้นตอนการสรางงานจริงๆ ที่สามารถนําไปใชได 
จะเริ่มจากขั้นตอนพื้นฐานจนถึงขั้นตอนระดับสูงเปน Step ขั้นตอนตางๆ จะเชื่อมโยงกันตลอด 
การพิมพตัวอักษร 
           การพิมพตัวอักษรใน Dreamweaver เหมือนกับการใช Microsoft Word หากเคยใชมาบางก็จะเปนการงายในการ 
ทําความเขาใจ 
การพิมพขอความ 
          สามารถพิมพเขาไปในหนา Document ไดเลย และลอง Preview ดูโดยการกด F12 ( เปนการจําลอง Browser ) เรา
จะเห็นไดวา ตัวอักษรที่พิมพจะเหมือนกันกับที่ Preview ทุกประการ นอกจากนั้นยังมีคุณสมบัติพิเศษที่สามารถปรับแตงได โดย
การใช Properties 

 
วิธีใช 
       Format เปนรูปแบบของอักษรสามารถเลือกไดตามตองการ 

 
      Paragraph การพิมพแบบตอเนื่อง 
      Heading 1-6 การพิมพหัวขอเรื่องตามขนาด Heading 1 เปนขนาดใหญที่สุดเรียงตามลําดับ การใชเลือกกอนพิมพ 
               หรือถาพิมพไปแลวจะใชไดโดยการ Click Mouse คางแลวปายทั้งขอความที่ตองการจากนั้นมาเลือกที่ Propreties 
> Format ตัวอักษรก็จะเปลี่ยนตาม                สวนตัวอักษรที่ไมไดเลือกก็จะไมมีการเปลี่ยนแปลง 
      ในหนา Document เดียวกันเราสามารถใช ตัวอักษรหลายแบบโดย Click ที่ลูกศรในชอง Default Font จะมี Font 
อื่นใหเลือก สวนคา Default Font จะเปน Font                ที่ไดทําการ Set ไวในตอนตน 
      Size ขนาดของตัวอักษร 
      การใชตัวหนา และตัวเอน ตัวหนา Click ที่ B และตัวเอน Click ที่ ตัว I 
      การจัดให ชิดซาย ชิดขวา หรือก่ึงกลาง ( เหมือน Word ทุกประการ ) 
      การใชหัวขอยอย จะเปนจุดหรือตัวเลขก็ได 
      เปลี่ยนสีตัวอักษร Click ที่ชองสี่เหลี่ยมจะมีจานสีใหเลือก 
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ขอจํากัดของการพิมพตัวอักษร 
           เนื่องจากการพิมพไมสามารถเวนวรรคตัวอักษรไดเกินหนึ่งตัวอักษร ทําใหการจัดรูปแบบการยอหนา ไมสามารถทําได 
วิธีแกไขโดยการใช Object ในหัวขอ Character ภายในจะมีเครื่องมือใหใชหลายอยางเปนเครื่องมือที่ในเวอรช่ันเกาไมมี 
      การขึ้นบรรทัดใหมโดยการกด Enter ในโปรแกรมจะเปนการเวน 2 บรรทัด  
      ถาหากตองการเวนหนึ่งบรรทัดสามารถทําไดโดยการใช Character ในหัวขอ BR ( Line Break ) หรือกด Shitf คาง
พรอมทั้งกด Enter  
      การเวนวรรคแบบไมจํากัดทําไดโดยการเลือกที่ Non Breaking Space  
 
การจัดรูปแบบอักษร  
Format การจัดรูปแบบตัวอักษร 
            การจัดรูปแบบตัวอักษรหรือเรียกวา Format ใน Dreamwearver มีการใชคําสั่งเหมือนกับ Microsoft word การ Format text ใน 
Dreamweaver มีสองรูปแบบคือ HTML Tags กับ Style Sheet โดย Css หรือ Style Sheet จะใชเฉพาะ Browser 4.0 ขึ้นไปเทานั้น แต
จะขอแนะนําใหใชคา Css จะดีกวาการใชคา Css มาชวยในการทําเวบเพื่อชวยประหยัดเวลาในการเซ็ท Font ทีละยอหนา และเปนการ
บังคับใหผูชมเวบใช Font ที่เรากําหนดเทานั้น 
Formatting text wirh html tags 
           คือการเขียน Tags HTML เพื่อชวยจัดยอหนา และขนาดหัวเรื่องเทานั้นเองการนําไปประยุกตใชงานคอนขางจํากัด แตมีขอดีคือ 
Browser ทุกรุนจะสามารถ Format ดวย Tags เหลานี้ได 
การเรียกใช Formatting text with HTML tags 
          ใหทดลองพิมพขอความอะไรก็ไดลงในหนาเวบเพจ แลวลองมาจัดระเบียบดวยวิธีนี้ 

 
      พิมพขอความ ปายทับขอความที่ตองการจัด 
      การเรียกใช โดยการเลือกที่เมนู Text > Styles หรือคลิกขวาที่ขอความ 
      Align เปนการจัดขอความใหชิดซาย กลาง หรือขวา 
      Style เปนลักษณะของตัวอักษรเหมือนกับ word เชน ตัวหนา ตัวเอียง ขีดเสนใต 
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ไฮเปอรลิงคหมายถึงอะไร ? 
ไฮเปอรลิงค (Hyperlink) เปนตําแหนงที่ใชเช่ือมโยงขอมูลจากที่หนึ่งไปอีกที่หนึ่ง ซึ่งจุดที่ใชสรางเปนไฮเปอรลิงคนั้นอาจจะใช
ขอความหรือรูปภาพก็ได  
 
การเชื่อมโยงขอมูล (Link) 
   ลิงคสามารถแยกเปนประเภทใหญๆ ไดสองประเภทคือการลิงคแบบ 
        Absolute Link : เปนลิงคที่ตองอางอิงขามระหวางโดเมน เชนการลิงคไปยังเวบไซทอื่น และจะตองระบุช่ือโดเมน
ทั้งหมด เชน ทําการลิงคไปที่ Hotmail ตองระบุคือ              http://www.hotmail.com ถึงจะสามารถลิงคได 
        Relative : เปนการลิงคภายในเวบของเราเอง จะอยูในโฟลเดอรเดียวกัน การลิงคไมยากมากนัก  
        การทําลิงคสามารถที่จะทํา ไดหลายวิธีและสามารถที่จะลิงคไปยังหนาอื่นหรือหนาเดียวกันก็ทําไดวิธีการทําลิงค มีหลายวิธี 
ดวยกันแลวแตความถนัดของ ผูใชแตละคน แตในที่นี้จะขอนแนะนําตั้งแตวิธีที่งายที่สุดจนไปถึงวิธีที่ซับซอน  
การทําลิงคขอความ 
        เปนการลิงคที่งายและไมยุงยากกอนที่จะทําการลิงคจําเปนตองสรางไฟลที่เปนเปาหมายที่จะทําการลิงค ใหทําดังนี้ 
            กด F8 เพื่อเรียก Site ใหสรางไฟลขึ้นใหมดังนี้ index.html , address_book.html , my_picture.html 
 
         หลังจากที่ไดสรางไฟลเรียบรอยแลวใหเริ่มทํางานที่หนา index.html โดยการดับเบิ้ลคลิกที่ไฟล index  
         จากนั้นจะมาเริ่มตนที่หนา Document index.html ใหทําการพิมพขอความวา Address Book และ My Picture 

 
         
   ขั้นตอนตอไปเปนขั้นตอนการลิงคทําไดโดยการปายทับขอความ Address Book จากนั้นใหมาที่ Porperties 
inspector                 ในชองลิงคใหคลิกที่สัญลักษณรูปโฟลเดอรดังรูปดานลาง 
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   จากนั้นจะมี Dialog box ใหเลือกไฟล address_book.htm จากนั้นคลิก Select  
 

 
       
          ตอมาใหการเลือกขอความ My Picture ใหพรอมที่จะทําการลิงค ใหเริ่มทําการลิงคเหมือนกับขอความแรกแตใหเลือก
ไฟลใน Dialog box เปน my_picture.htm                  จากนั้นคลิก Select  
           หลังจากเลือกไฟลแลวใหทดสอบการโดยการกด F12 เปนการดูผาน Browser ทดลองคลิกที่ลิงคที่ไดทําไว 
           หลังจากคลิกที่ Address Book ทาง Browser จะเปดหนาเพจขึ้นใหมเปนหนาเพจของ address_book.htm จะ
สังเกตไดจากชอง Address 

 
           

 การทําลิงคสามารถพิมพเขาโดยตรงในกรณีที่เราสามารถจําช่ือได โดยพิมพในชอง Link 
 

 
 

           หรืออีกวิธีหนึ่งจัดวาเปนวิธีที่แนนอนไมผิดพลาดในการลิงค แตเราตองเปด Site Local Folder และยอ Window 
                ของทั้งสองใหเล็กสามารถมองเห็นไดทั้งสองหนาตาง 
           จากนั้นทําการคลิกที่ Point to file คางแลวลากมายังช่ือไฟลใน Local Folder ที่ตองการลิงค 
           แตวิธีดังกลาวจะใชเนื้อที่ในการทํางานมากและมีขอจํากัดสําหรับหนาจอที่เล็กเนื้อที่ในการทํางานก็จะนอยลงไปดวย 
               แตแนะนําใหใชวิธีแรกดีเพราะสะดวกและไมเกิดการผิดพลาด 
การลิงคไปยังเวบไซตอ่ืน  
              เราสามารถที่จะทําเวบของเราเปนเวบบริการหรือรวมลิงคใหผูอื่นสามารถไปยังเวบไซทอื่นไดอีกดวยเพื่อเปนความ
หลากหลาย ในเวบของเรา และยังสะดวกกับเจาของเวบเองอีกดวยโดยไมตองพิมพ URL เขาไปใหม แตสามารถคลิกที่เวบของ
ตัวเองก็ สามารถไปยังเวบ ที่ตองการได เราอาจจะทําลิงคเฉพาะเวบที่เราใชบอยๆ เชน เช็คเมล สงเพจ และอื่นๆ  
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ขั้นตอนการทําลิงค 
          ใหเปดไฟล index.html พรอมที่จะทํางาน 
          พิมพขอความลงไปดังนี้ 
          Hotmail 
          Yahoo 
          Pantip 

 
          จากนั้นใหปายทับขอความ Hotmail ใหทํางาน 
          มาที่ Properties inspector  
          ในชอง Link ใหพิมพ URL เขาไปคือ http://www.hotmail.com
 

 
 

          สวน Yahoo และ Pantip ใหทําขั้นตอนเดียวกันโดยเปลี่ยนลิงคไปที่ http://www.yahoo.com และ 
http://www.pantip.com 
          ทดสอบโดยการกด F12 แตยังไมตองคลิกใน Browser เพราะเรายังไมไดทําการตอเช่ือมอินเตอรเน็ต ใหทดสอบโดย
การ เอาเมาสมาวางทับขอความโดยไมตองคลิก               จากนั้นใหสังเกตจาก Task bar ดานลางจะระบุที่ไปถาทําการคลิก แต
ถาไดทําการ ตอเช่ือมอินเตอรเน็ตก็สามารถคลิกไดเลย 
 

 
 
 

http://www.hotmail.com/


   

 
          การสรางเว็บเพจดวย Dreamweaver  

9
การสราง Link ภายในเอกสารเดียวกัน 
Anchor Name  
           เปนการลิงคภายในเวบเพจเดียวกัน ใชในกรณีที่มีหัวขอยอยหลายหัวขอและแตละหัวขอมีเนื้อหาที่มาก เพื่อเปนการสะดวก 
ในการคนหาเพราะวาอยูภายในเวบเพจเดียวกัน 
ขั้นตอนการทํา 
          เปดหนา Document พรอมทํางาน 
          พิมพขอความดังนี้ 

 
 

         topic เปนตัวอยางการแสดงหัวขอยอย ในที่นี้ใช TOPIC 1 ,2 , 3 , 4 ตามลําดับดังรูป  
         หัวขอ ในที่นี้ใช x แทนรายละเอียดของแตละ TOPIC  
         จากนั้นใหมาที่ Object มาที่หัวขอ Invisibles 

 
 

         ใหเลื่อนเคอรเซอรมาใหหนา TOPIC 1  
         ใหคลิกที่ Anchor Name ใน Object Invisible 

 
          จากนั้นใหต้ังช่ือใน Dialog box ใหต้ังช่ือเปนช่ือที่สื่อใหเรารูวาคืออะไร ในที่นี้ต้ังเปน b2 

 
          คลิก OK 
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          ตอไปเปนการทําลิงคมาหาหัวขอ TOPIC 1 ที่เราไดสราง Anchor Name ทําการปายทับขอความ TOPIC 1 ดัง
ภาพ 

 
           

จากนั้นใหมาที่ Properties inspector ในชองลิงคใหใสคา #b2 เปนการทําลิงคภายในเพจเดียวกัน 
 

 
 

          ใหทําแบบเดียวกับ TOPIC ที่เหลือโดยใสช่ือเปน b3 b4 b5 ตามลําดับ และอยาลืมใสเครื่องหมาย # ในชองลิงคและ
ตามดวย b3 b4 b5  
          ทดสอบโดยการกด F12 และลองคลิกที่ลิงค สังเกตวาหลังจากที่คลิกหนาเพจจะเลื่อนมายัง TOPIC ที่ไดทําลิงคไวโดย
อัตโนมัติ 
 
การใสรูปภาพลงในเวบเพจ(Image) 
           ในบทเรียนนี้จะไดเรียนรูเกี่ยวกับการนํารูปภาพมาประกอบในหนาเวบเพจ ซึ่งมีสวนสําคัญอยางยิ่งในการตกแตงหนาเวบ
เพจ ชวยใหเวบเพจมีความนาสนใจมากขึ้น ไมเครียดเกินไป โดยเฉพาะสําหรับเวบไซตที่ขายสินคานั้น จําเปนอยางยิ่งที่จะตองมี
รูปภาพของสินคาที่จะขายแสดงอยูบนเวบเพจเพื่อใหลูกคาเขามาดูกอนตัดสินใจซื้อ แตปญหาหนึ่งที่พบกันบอยๆ สําหรับการเรียกดู
เวบเพจที่มีรูปภาพคือ เวบเพจดังกลาวจะแสดงผลบนเบราเซอรไดชา มีผลทําใหคนเขามาดูเกิดอาการเบื่อ จนบางครั้งอาจจะเลิกชม 
ประเภทของไฟลรูปภาพที่สามารถใชในเวบเพจ 
         สําหรับประเภทของไฟลรูปภาพที่ใชงานในคอมพิวเตอรนั้น มีอยูหลายประเภท ซึ่งเราจะแยกประเภทของไฟลเหลานี้ดวย
นามสกุลของไฟล ไดแก .bmp , .pcx , .tix , .tga , .wmf , .gif , .jpg , .png และอื่นๆ แตสําหรับประเภทของไฟลที่
สามารถนํามาใชบนเวบเพจและโปรแกรมเบราเซอรสามารถโดยทั่วไป สามารถอานไดมี 4 ประเภทคือ .bmp , .jpg , .gif 
และ .png และสําหรับโปรแกรม Dreamweaver เองก็สามารถทํางานกับไฟลเหลานี้ไดเชนกัน 
 
BMP (Bitmap) 

ไฟล .BMP สามารถแสดงรายละเอียดสีไดละเอียดและแมนยํา แตมีขนาดไฟลใหญมาก จึงไมนิยมใช 
JPG (Joint Photographics Expert Group) 

ไฟล .JPG สามารถแสดงรายละเอียดสีไดถึง 16.7 ลานสี เหมาะสําหรับรูปภาพที่มีรายละเอียดของสีจํานวนมาก เชนรูป
ถาย หรือรูปที่ไดจาการสแกน เขามา และมีขนาดเล็กกวา .BMP มาก ถึงแมจะไมสามารถแสดงรายละเอียดของภาพได
เทา .BMP ก็ตามแตอยูในเกณฑที่ยอมรับได ทําใหนิยมใชมากกวา .BMP 

GIF (Graphic Interchange Farmat) 
ไฟล .GIF สามารถแสดงรายละเอียดสีได 256 ส ีเหมาะสําหรับรูปภาพที่มีจํานวนสีไมมาก เชน รูปภาพ รูปการตูน เปน
ตน ซึ่งไฟล .GIF นี้มีขนาดเล็กที่สุดเมื่อเทียบกับ .BMP และ .JPG  

PNG (Patable Network Graphic) 
ไฟล .PNG สามารถแสดงรายละเอียดสีไดถึง 162.7 ลานสี และมีขนาดเล็กเหมือน .GIF แตยังมีไมคอยไดรับความนิยม 
เนื่องจากเพิ่งเกิดขึ้นมาไดไมนาน แตอนาคตคาดวาจะเปนที่นิยม และมาแทนที่ .GIF ในที่สุด 
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การใสรูป 
ขั้นตอนที่ 1 คลิกที่ Insert Image 

 
ขั้นตอนที่ 2 เลือกรูปภาพที่ตองการใส และคลิก select 
 

 
 
ขั้นตอนที่ 3 จะไดรูปภาพที่เราตองการแสดงออกมา 

 
การทําลิงคเมล Link E-mail 
            การทําลิงคเมลสวนมากจะเปนการใหผูที่ชมเวบไซทไดติดตอกับเจาของเวบไซท กลาวคือก็เปนการสงเมลธรมดานั้นเองแต
พิเศษอยูที่ผูชมไมตองพิมพที่อยู E-mail Address ของเรา เพียงพิมพขอความติชมเทานั้น เหมือนเปนการสงเมลอัตโนมัติโดยไม
ตองไปที่ผูใหบริการเมล โดยหลังจากคลิกลิงคเมลทางBrowser จะทําการเปดโปรแกรมสงเมลใหโดยอัตโนมัติสวนมากถาเปน IE 
จะเปดโปรแกรม Outlook ให 
วิธีลิงคเมลล 
         ใหเปดไฟล index.html 
        ใหพิมขอความวา คําติชม 
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หรืออีกวิธีคือ        ใช Object โดยเลือกที่ Insert Email Link 

 
 
        ภายใน Dialog box ใหกําหนดดังนี้ 

 
 

        Text ใหใสขอความ คําติชม 
        E-mail ใหใสที่อยูของเมล 
        คลิก OK 
        จากนั้นทดสอบโดยการกด F12 คลิกขอความจากนั้นโปรแกรมจะเรียกโปรแกรม Outlook ขึ้นมาใหใสขอความจากนั้น
คลิกสง ( send ) 

 
 
การใชรูปภาพเปนลิงค 
           สวนมากจะมีสองประเภทใหญคือ การใชภาพทั้งภาพทําลิงค หรืออีกอยางก็คือการใชบางสวนของภาพทําลิงคโดยใช 
Hotspot เลือกเฉพาะที่ 
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การใชภาพทั้งภาพเปนลิงค 
         การใชภาพเปนลิงคนิยมสรางภาพขึ้นมาเองทําเปนรูปปุมกดจะใชรวมกับ Rollover คือลักษณะกอนเอาเมาสผานจะเปนอีก
รูป   พอเอาเมาสผานหรือวางที่รูปก็จะเปลี่ยนเปนอีกรูปหนึ่งและยังสามารถเปนลิงคไดอีกดวย การทําดังกลาวจะกลาวถึงในหัวขอ 
Rollover ในที่นี้จะกลาวถึงการทําลิงคแบบธรรมดา 
        สรางรูปเก็บไวในโฟลเดอร image ที่ไดสรางไว 
        มาที่หนา Document index.html 
        คลิก Insert image จาก Object 

 
        เลือกรูปจาก Dialog box 
        คลิก Select 
        จากนั้นใหคลิกที่รูปภาพในหนา Document ที่ได Insert มา 
        ใหมาที่ Properties ในชองลิงคใหคลิกที่รูปโฟลเดอรเหมือนกับการทําลิงคตัวอักษรดังที่ไดนําเสนอไปแลว 
 

 
      
          จากนั้นเลือกไฟลที่ตองการลิงคไปหา หรือจะลิงคไปยังเวบไซทนอกก็ได 
 
การลิงคภาพแบบ Hotspot หรือ Image Map 
        การลิงคแบบ Hotspot การใชสวนมากเปนการลิงคเพียงบางสวนของภาพ ภาพสวนมากจะเปนภาพที่มีขนาดใหญเพียงภาพ
เดียว 
ขั้นตอนการทํา Hotspot  
       มาที่หนา Document พรอมทํางาน 
       Insert รูปภาพที่ไดเตรียมไว ( การดึงรูปภาพเหมือนปกติที่ไดกลาวมาแลว ) 
       ในตัวอยางนี้เปนรูปภาพใหญและมีสวนประกอบยอยที่จะทําเปนที่ลิงค 
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        คลิกที่ภาพใหทํางาน 
        มาที่ Properties inspector 
        ใหทําการขยาย Properties inspector เปนแบบ Full 
 

 
 

       ชอง Map ใหกําหนดชื่อ 
       คลิกรูปสี่เหลี่ยมดังภาพ  
       จากนั้นใหมาที่รูปภาพในสวนที่ตองการทําเปนลิงค 
 

 
 

       ทําการลากเมาสคางใหเปนดังรูปตัวอยาง 
       จากนั้นใหคลิกที่ขอบที่ไดทําการลากไวใหทํางาน 
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       ในตัวอยางดานบนเปนการใช Hotspot หลายรูปแบบทั้ง สี่เหลี่ยม วงกลม และรูปทรงอิสระ 
       ใหคลิกขอบให Hotspot ทํางานในตัวอยางดูไดจากรูปวงกลม จะมีปุมขึ้นรอบรูป 
       ใหมาที่ Properties inspector  

 
       Link ใหกําหนดลิงคตามปกติโดยหากเปนเวบนอกใหพิมพเขาไปเลย หากเปนลิงคภายในใหทําตามขั้นตอนที่ไดกลาว
มาแลว 

 
 

        ในตัวอยางเปนการลิงคไปที่ Yahoo.com  
        ทดสอบโดยการกด F12  
        ใหเอาเมาสมาคลิกที่เราไดทําการลิงคแบบ Hotspot จะสังเกตไดวาบริเวณอื่นที่ไมไดทํา Hotspot ไมสามารถที่จะลิงคได 
ถึงแม วาจะเปนภาพเดียวกัน 
 
( การเปลี่ยนภาพเมื่อคลิกเมาส ) Rollover Image 
         เปนเทคนิคที่ใชกันแพรหลายใหทั้งความสวยงามและความตื่นตาตื่นใจกับผูชมไดเปนอยางดี ในสมัยกอนตองมีความรูดาน
ภาษา JavaScript ถึงจะทําได แตดวยความสามารถของ Dreamweaver ชวยใหผูที่ไมรูภาษา JavaScript ก็สามารถเพิ่ม
ลูกเลนนี้เขาไปได (ดูตัวอยางที่http://www.ntinfonet.com/books) 
 
ขั้นตอนการทํา 
          คลิก Cursor ใหอยูในตําแหนงที่ตองใส Rollover Image  
         กดปุม Rollover ใน Object palette หรือที่เมนู Insert > Rollover Image 
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จะมี Dialog box ขึ้นมาใหใสคาดังนี้ 

 
  
         Image Name ใสช่ือถาไมใสทางโปรแกรมจะกําหนดใหเปน Image1 ,2,3,4………… 
         Original Image ใหคลิกรูปจาก Browser แลวเลือกรูปที่ตองการ ( เปนรูปที่กําหนดใหเปนปุมกอนที่เมาสจะลากผาน 
         Rollover Image ใหคลิกรูปจาก Browser แลวเลือกรูปที่ตองการ ( เปนรูปที่กําหนดใหเปนปุมเวลาที่ลากเมาสผาน 
         ใสเครื่องหมายถูกหนา Preload Rollover Image ( เพื่อเปนการ Load รูปภาพลวงหนาเพื่อใหการทํางานของ 
Rollover เปนไป อยางราบรื่น ) 
         When Clicked, Go To URL ใสล้ิงคที่ตองการใหเรียกขึ้นมาหลังจากที่คลิกปุมแลว 
         หลังจากเรียบรอย คลิก OK แลวจากนั้นใหทํางานการทดสอบดูใน Browser โดยการกดปุม F12 เมื่อ Browser เปด
ขึ้นมาใหลอง เลื่อนเมาสผานรูปดู 
ตัวอยางการใช Rollover 
จากภาพขางลางคุณจะเห็นวาเปนภาพธรรมดานะครับ แตมันไมใชอยางที่คุณคิด เมื่อคุณเอาเมาสไปวางที่ตําแหนงภาพคุณจะเห็นวา
มันเปนการลิงค เมื่อเมาสไปวางตําแหนงนั้น รูปก็จะเปลี่ยนรูปเปนรูปอื่นทันทีตามที่เรากําหนดไว 
  
วิธีการยกเลิก Rollover Image 
สําหรับการยกเลิก Rollover ใหคุณทําตามขั้นตอนดังนี้ 
1. คลิกที่ตําแหนงรูปที่ทํา Rollover ไว 

 
 
2. ที่วินโดว Bahaviors ในชอง Events คลิกรายการของการกําหนด Rollover แลวคลิกที่ปุมเครื่องหมายลบ จบครบทุก
รายการ 
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ประโยชนของการสรางตาราง  
            สําหรับหนาเวบเพจ การใชตารางจะมีประโยชนคอนขางมาก นอกเหนือจาการกแสดงขอมูลที่เปนตาราง เชน ตารางแค็ต
ตาล็อกสินคา ตารางราคาสินคา เปนตน การใชตารางยังชวยในการวางตําแหนงของขอความ หัวขอ หรือรูปภาพตางๆในหนาเวบเพ
จอีกดวย ซึ่งคุณจะพบวาหากคุรใชตารางในการวางตําแหนงของออปเจกตตางๆ จะไดงายมากขึ้น สรุปไดวาตารางจะชวยในการ
แสดงขอมูลที่เปนตาราง และวางโครงรางของหนาเวบเพจนั่นเอง 
Table 
           Table มีสวนชวยในการจัดระเบียบขอความและรูปภาพทั้งหลาย มีเพียงโปรแกรมใน Dreamweaver เทานั้นที่สามารถ 
เปลี่ยนเวบที่ออกแบบดวยเลเยอรมาเปนตาราง ไดทําใหเราสามารถออกแบบไดอยางอิสระในตอนแรก จากนั้นจึงเปลี่ยนมา ใชระบบ
ตารางเพื่อใหเปดดูใน Browser ไดทุกระบบไมผิดเพี้ยน (สาเหตุที่ Dreamweaver ตองมีคําสั่งแบบนี้ เพราะ Browser รุนเกา
ไมสามารถใชเลเยอรไดนั่นเอง)Tool บางตัวที่ใชเขียนเวบเพจจะใชหลัก Table ในการออกแบบเปนหลักเชน FRONTPAGE 
98 เนื่องจากใชงานงาย และเมื่อดูใน Browser จะไดผลไมผิดเพี้ยนเลย แตมีขอดอยคือไมใหความอิสระ ในออกแบบเหมือนเล
เยอร 
สวนประกอบของตาราง (Table) 
        Rows (แถว) = รายละเอียดในแนวนอนหรือแนวแถวของตาราง 
        Columns (คอลัมน) = รายละเอียดในแนวตั้งหรือแนวคอลัมนของตาราง  
        Cell (เซลล) = รายละเอียดของชอง 1 ชองในตาราง 
        Border (เสนขอบ) = เสนขอบของตาราง 
        Width = กําหนดความกวางของตารางซึ่งมีหนวยความกวางสองแบบใหเลือกคือ 
         Percent : กําหนดเปนเปอรเซ็นตเทียบกับความกวางของหนาจอเวบเพจบนโปรแกรมเบราเซอร 
         Pixels : กําหนดเปน Pixels หรือเปนจุดบนหนาจอ 
         Cell Pading = กําหนดระยะหางระหวางขอบเซลลกับขอความของเซลล 
         Cell Spacing =กําหนดระยะหางระหวางชองเซลลแตละชอง 
การสรางตาราง 
        หลังจากไดทราบสวนประกอบตางๆของตารางแลว ในขั้นตอนตอไปคุณจะไดเรียนรูเกี่ยวกับวิธีสรางตาราง  
     เลือกตําแหนงที่ตองการใสตาราง ดวยการวางเคอรเซอรที่ตําแหนงนั้น คลิกปุม Table ใน Object Palette หรือเลือกเมนู 
Insert > Table  

 
      จะมี Dialog box ขึ้นมาใหเลือกจํานวนและคาตางๆ 
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Table property 
       หลังจากที่เลือก Table แลวมาดูคาตางๆใน Property inspector วาสามารถกําหนดคาอะไรไดบาง 
 

 
        Table Name : ต้ังช่ือไวเรียกอางอิง 
        Rows : สามารถเพิ่มจํานวนแถวไดโดยพิมพตัวเลขเพิ่มเขาไป 
        Cols : สามารถเพิ่มจํานวน Columns ไดโดยการเพิ่มจํานวนตัวเลขเขาไป 
        W และ H : ความกวางและความสูงของตาราง ถาความกวางถูกเซ็ทหนวยเปนเปอรเซ็นหมายถึง สั่งให Browser ปรับ
ความ             กวางของหนาจอซึ่งจะทําใหความกวางของตารางไมแนนอน ถาระบุเปนหนวย Pixel หรือ หนวยอื่นจะดีกวา 
        Cell Pad ชองวางระหวาง Cell โปรแกรมตั้งไวที่ 1 
        Cell Space ชองวางระหวาง Cell โปรแกรมตั้งไวที่ 2 
        Align : กําหนดชิดซาย กลาง หรือ ขวา 
        Border : ขอบของตาราง 
        Bg Color : สีพ้ืนหลังของตาราง 
        Bg Image : ใชรูปเปนพื้นหลังของตาราง 
        Brdr Color : สีของขอบของตาราง 
Porperty inspector ของ Row ,Column และ Cell 
           Porperty ในการใชงานแตละอยางจะไมแตกตางกันขึ้นอยูกับที่เราทําการเลือก Select ไมวาจะเปน Row Column 
Cell 
        Property สวนบนจะเปนการควบคุมตัวอักษรหรือรูปภาพที่นํามาใสในตารางเหมือนกับ Property ของ Font ที่ได
กลาวมาแลว 
        Property สวนลางเปน Property ที่ควบคุมตารางในสวนของ Row Column Cell 
        W และ H : ขนาดความกวางของ Cell ไมจําเปนตองปรับ 
        No Wrap : ชอง Wrap จะสั่งใหโปรแกรมทําการตัดคําเมื่อเจอประโยคยาวๆ แตจะขยายชองใหตามแนวนอนไปเรื่อยๆ 
จนกระทั่งหมดคําแลวจึงขึ้นบรรทัดใหม              (ไมตองติ๊กชองนี้) 
        Head : ในชอง Head จะทําใหชองตารางนั้นกลายเปนขอความ เหมือนสวนหัวตาราง คือเปนสวนใหญ ตัวหนา และจัด 
ตําแหนงอยูก่ึงกลางเสมอ 
        Bg : การนํารูปภาพมาทําเปนพื้นหลัง 
        Bg: เลือกสีทําเปนพื้นหลังถาเลือกรูปภาพแลวไมตองเลือกส ี
        Brdr : เลือกสีของขอบพรอมทั้งขนาดของขอบ 
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การแทรกตารางทั้งแถวและแนนคอลัมน 
เลือกแนวนอนที่จะทําการแทรกใหม 

 
 

แลวกด Crtl + M จะไดภาพดังรูปขางลาง 

 
การลบตารางทั้งแนวนอนและแนวคอลัมน 
เลือกแนวตารางที่จะลบดังรูป 

 
 
แลวกด Delete แนวตารางที่เลือกไวจะหายไปดังรูป  

 
 
***หมายเหตุ*** การลบคอลัมนก็เหมือนกันครับ เพียงแคเลือกเปนคอลัมนแลวกด Delete แคนี้ก็เปนอันเสร็จสิ้นการลบตารางที่
ไมตองการออก 
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ตัวอยาง Flash Button                 
             Flash Button ก็คือปุมที่ไดทําการสรางจากโปรแกรม Flash นั่นเองแลวนํามาใสใน DreamWeaver โดยใชคําสั่ง 
InsertFlash ซึ่ง เปน Plugin ดังนั้นผูที่สามารถทําปุม Flash ไดนั้นจําเปนอยางยิ่งที่ตองเขาใจ และสามารถสรางสรรคงานใน
โปรแกรมFlashไดเปน อยางดี แตใน Dream4 เราสามารถใชงานFlash Button ไดโดยเราไมจําเปนตองสรางขึ้นมาเอง และไม
มีความรูในการใช โปรแกรม Flash เลยแมแตนอย เพราะโปรแกรมDreamWeaver ไดรวมเอาความสามารถของโปรแกรม 
Flash เขามาไวใน DreamWeaver ใหเราสามารถเรียกใชงานไดเลยในรูปแบบของปุมสําเร็จรูป และยิ่งไปกวานั้นเรายังสามารถ
ปรับขนาด เปลี่ยน สีพ้ืนใหเขากับสีพ้ืนของเรา และเปลี่ยนตัวอักษรใหเปนไปตามที่เราตองการไดอีกดวย ดังไดเห็นจากตัวอยาง
ดานบน 
  
ขั้นตอนการสราง Flash Button  
      1. สรางไฟลงานขึ้นมา และเลือกที่ที่ตองการใสปุม Flash  
      2.ใหมาที่ Object เลือกใหเปนคําสั้ง Common เลือกที่ปุม Insert Flash Buton  

 
 

      3.ภายใน Dialogbox จะประกอบไปดวย  
 

 
 
         3.1 Sample : แสดงตัวอยางที่เลือกจาก Style  
         3.2 Style : สามารถเลือกปุมไดตามตองการและสามารถทดสอบไดโดยคลิกที่ตัวอยางจากชอง Sample  
         3.3 Button : ตัวอักษรที่จะกําหนดใหกับปุม Flash ใหทดลองพิมพคําวา Test  
         3.4 Font : เลือก Font ของตัวอัการตามที่ตองการ  
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         3.5 Size : กําหนดขนาดของตัวอักษรใหเลือก Size 13  
         3.6 Link : กําหนดเปาหมายใหกับปุมวาตองการใหลิงคไปที่ใด  
         3.7 Target : กําหนดใหทําการเปดหนา Window ใหมตามที่เรากําหนด ถาไมระบุคาโปรแกรมจะใชคาDefualt 
         3.8 BgColor : สําคัญมากในการทําปุมใหกลมกลืนกับพื้นหลังของเราใหกําหนดใหเปนสีเดียวกับพื้นหลัง  
         3.9 Save As : กําหนดชื่อใหกับปุม และกําหนดที่อยูของไฟล  
      4. คลิก Apply และ คลิกปุม Ok  
     เพียงเทานี้เราก็จะไดปุมที่มีลูกเลนไวในเวบของเรา แตอยาลืมที่จะสงไฟลของปุมที่ไดสรางไวไปยัง Server ดวยเพราะวาปุมที่
เราสรางก็คือ Plugin Flash นั้นเอง  
 
 
ขั้นตอนการสราง Flash Text  

1. Click Insert Flash Text จาก Object Commom    
หรือ คลิกที่เมนู Insert > Interactive Image> Flash Text  
2. ภายใน Dialog Box ใหกําหนดดังนี้ 

 
 
      2.1. Font : ใหกําหนด Font เปน Arial 
      2.2. Size : ใหกําหนดขนาดเปน 20 
      2.3. Color : กําหนดใหเปนสีแดง 
      2.4. Rollover Color : ใหกําหนดเปนสีน้ําเงิน ( เปนสีหลังจากที่เอาเมาสลากผาน )  
      2.5. Text : ใหพิมพคําวา Text ลงไป แลวใหต๊ิกเครื่องหมายถูกในชอง Show Font ดวย  
      2.6. Link : กําหนดใหลิงคไปยังที่ที่ตองการ ในที่นี้ไมตองระบุ  
      2.7. Taget : ไมตองกําหนด  
      2.8. BgColor : กําหนดใหเปนสีเดียวกับพื้นของเวบเพจ  
      2.9. Save As : ต้ังช่ือตามตัวอักษร  
3. คลิก Apply และ คลิกปุม Ok  
4. ทดสอบโดยการกดปุม F12 และทดสอบโดยการเอาเมาสวางทับตัวอักษร  
 


